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1. Introduction

1 Introduction

DSL1 is an engine management system for engines equipped with Bosch
M-type EDC diesel injection pumps, such as Mercedes-Benz OM605/OM606.
Also capable of controlling Bosch VP37 pumps as found on many Volkswagen/Audi
applications as well as BMW and Mercedes Benz OM602.98x engines.
To be able to run an engine, apart from the injection pump itself, two
sensors are required. A throttle pedal position sensor and an engine speed
sensor. Most applications will also use a manifold pressure sensor (MAP
sensor) and if glow plug or fan control is required, then an engine coolant
temperature sensor must be fitted. All of those sensors come standard on
the OM605/606 turbo engines.
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2. Wiring

2 Wiring

2.1 Pin-outs and description
2.1.1 Pin numbering

(a) Connector B (b) Connector A

Figure 2.1: Connectors on the back of the controller and their pin
numbering.

Figure 2.2: Connector C as found on controllers with serial numbers 200
and up, located between connectors A and B.
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2. Wiring 2.1. Pin-outs and description

2.1.2 Connector A pin-out
Pin I/O Function Note
1 OUT 5V supply for pedal

position sensor
200mA max

2 IN Analog 0 - Pedal
position sensor
primary

100kΩ pull-down

3 IN Analog 1 - Pedal
position sensor
secondary

22kΩ pull-up

4 OUT Ground return for
pedal position
sensor

5 IN Analog 4 0-5V 22kΩ pull-up
6 IN Analog 5 0-5V 22kΩ pull-up
7 IO CAN high 120Ω termination on board
8 IO CAN low 120Ω termination on board
9 OUT Output 1 Low-side switch, 3A max2, 1kΩ

pull-up to 12V
10 OUT Output 2 Low-side switch, 3A max
11 IN Power ground
12 IN Power ground
13 OUT 5V supply for

sensors
200mA max

14 IN Analog 2 - Coolant
temperature sensor

3kΩ pull-up

15 IN Analog 3 - MAP
sensor 0-5V

33kΩ pull-up

16 OUT Ground return for
sensors

17 IN Analog 6 0-5V 33kΩ pull-up
18 IN Digital in 1 Only on S/N 200 and up. Active

low, 12V tolerant. 4.7kΩ pull-up
to 5V.

19 IN Engine speed input
VR or logic level

2.2kΩ pull-up

20 IN Vehicle speed input
VR or logic level

2.2kΩ pull-up until S/N 200.
4.7kΩ onwards.

21 OUT Output 4 Low-side switch, 3A max
22 OUT Output 3 Low-side switch, 3A max
23 IN Switched +12V

supply
24 IN Switched +12V

supply

2Hardware revision 4 (serial numbers 200 and onwards) can support up to 5A
current on the programmable outputs. Combined current of all programmable outputs
must not exceed 5A on older hardware or 10A on revision 4 with extra power ground
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2. Wiring 2.1. Pin-outs and description

2.1.3 Connector B pin-out
Pin I/O Function Note
1 OUT Rack solenoid

negative
IP brown/white wire -
brown/white wires in OEM loom

2 OUT Rack solenoid
negative

IP brown/white wire -
brown/white wires in OEM loom

3 IN Rack position
reference coil

IP green wire - white wire in OEM
loom

4 IN Rack position
(actual value) coil

IP black wire - yellow wire in OEM
loom

5 OUT Rack solenoid
positive

IP brown wire - red/blue in OEM
loom

6 OUT Rack solenoid
positive

IP brown wire - red/blue in OEM
loom

7 OUT Sensor ground
return

Shield if present

8 OUT Sensor ground
return

IP red wire - red in OEM loom

2.1.4 Connector C pin-out
Pin I/O Function Note
1 IN Power

ground
Necessary if exceeding 5A combined current on
all programmable outputs. Recommended in
every case.

2 OUT Output
5

Low-side switch, 5A max

3 OUT Output
6

Low-side switch, 5A max

4 OUT Glow
relay
comms

Dedicated pin for standard OM606
microcontroller glow plug relay (PWM
communications). Built in pull-up.

5 OUT Output
7

Low-side switch, 5A max, no PWM capability.

6 OUT Output
8

Low-side switch, 5A max, no PWM capability.

2.1.5 Expansion board
In late 2019 an expansion board was introduced that is compatible with
the later board revision (controller serial numbers 200 and up). The
expansion board installs inside the case and adds a fourth connector on
the back providing 8 additional analog inputs, 2 additional digital inputs
and 4 additional switching outputs. As of firmware 1.29 these features
are all visible in the configuration but perform no function unless the
expansion board is installed.

pin connected.
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2. Wiring 2.1. Pin-outs and description

Figure 2.3: Connector D, note that it is installed upside down on the
controller.

Pin I/O Function Note
1 IN Power

ground
Join to wires connecting main ECU ground.
Not necessary if not using outputs 9-12.

2 OUT Output 9 Low-side switch, 5A max, no PWM
capability.

3 OUT Output 10 Low-side switch, 5A max, no PWM
capability.

4 IN Digital in
3

Active low, 12V tolerant. 10kΩ pull-up to
5V.

5 IN Analog in
10

3kΩ pull-up

6 IN Analog in
8

51kΩ pull-up

7 IN Analog in
12

51kΩ pull-up

8 IN Analog in
14

51kΩ pull-up

9 OUT Sensor
ground
return

Do not connect to any other ground

10 IN Power
ground

Join to wires connecting main ECU ground.
Not necessary if not using outputs 9-12.

11 OUT Output 11 Low-side switch, 5A max, no PWM
capability.

12 OUT Output 12 Low-side switch, 5A max, no PWM
capability.

13 IN Digital in
2

Active low, 12V tolerant. 10kΩ pull-up to
5V.

14 IN Analog in
11

51kΩ pull-up

15 IN Analog in
9

51kΩ pull-up

16 IN Analog in
13

51kΩ pull-up

17 IN Analog in
15

51kΩ pull-up

18 OUT 5V supply
for sensors

200mA max (shared with other 5V outputs)
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2. Wiring 2.1. Pin-outs and description

Figure 2.4: Solder jumpers on expansion board. Solder jumpers are the
pads with no component mounted. SJ2 on top, SJ1 on bottom.

Digital inputs 2 and 3 can be configured for activation by a positive
voltage instead of by grounding by the means of bridging solder jumpers
on the expansion board. SJ1 pulls down input 3 and SJ2 pulls down
input 2.
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2. Wiring 2.2. Wiring diagram

2.2 Wiring diagram

Figure 2.5: Typical basic wiring, not shown is the injection pump.
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2. Wiring 2.3. Wiring guidelines

2.3 Wiring guidelines
2.3.1 Grounding

The controller should be connected to the battery negative terminal or
another reliable grounding point by a pair of 1.5 mm2 wires or a single
6 mm2 wire joined to smaller wires near the connector. An improper
ground connection will cause electrical noise and possibly faults with
controller operation. If utilising factory Mercedes wiring, joining all of the
supply ground wires for the Bosch ECU should suffice.

2.3.2 12V feed
The preferred method of feeding the controller is to keep the wiring from
the battery positive terminal to the controller as short as possible to limit
electrical noise and voltage drop. This is best done by routing a wire
directly from the controller to the battery, with a 20A fuse and relay in
line. If using factory Mercedes wiring, using factory fitted switched 12V
feed via main relay should suffice but an extra relay must be fitted to
switch the main relay negative.

2.3.3 Fuel shut-off solenoid
If your engine has a fuel shut off solenoid fitted (the little black box
bolted to the inlet on the injection pump), connect that to 12V from the
ignition switch or pin 6 of connector B on the ECU. The fuel temperature
sensor is not utilised.

Pin Wire colour Function Where connected
1 brown/white FTS ground not connected
2 brown solenoid ground any power ground
3 yellow/black solenoid power switched 12V source
4 blue/white FTS signal not connected

Figure 2.6: Fuel shut off solenoid wiring

2.3.4 Glow plugs
The ECU can control a glow plug relay, and as of firmware version 1.20
using the Mercedes EDC glow relay unmodified is now the preferred
option.
The Mercedes relay has a few connections. An M6 stud that connects
directly to the battery positive terminal. A big connector with 6 pins that
connects to the glow plugs. The same relay fits 5 or 6 cylinder engines, 5
cylinder engines will just leave one pin unused.
Then there is a small connector with three pins. The pin terminals are
labeled 31 for ground, DL for data link and TK which is not used. The
ground wire is brown and the data link wire in the middle is usually
white but sometimes uses other colours.
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2. Wiring 2.3. Wiring guidelines

There must be a pull-up resistor valued between 1-10kΩ connecting the
data link wire to a switched 12V source. The easiest way to accomplish
this is to use programmable output 1 on the DSL1 (pin 9 of the 24 pin
connector) which has a 1k pull up fitted internally so no external resistor
is required.
If you wish to use the DSL1 to drive a petrol engine tachometer, you
must use another output for the glow relay and thus must use a pull-up
resistor.
To control the Mercedes glow relay, the output used must be configured
for PWM glow control in the Calibrator software. If using a modified
Mercedes relay or using any general purpose relay, select the Glow control
setting for the output.
Units with serial number 200 and up have a dedicated output for the
PWM glow relay, pin 4 of the 6 pin connector. This output has a built
in pull-up and no configuration is necessary to enable it. Presently, no
diagnostics are performed on the glow relay. If a glow indicator on the
dashboard is desired to indicate when heating of the glow plugs is done,
that must be taken from one of the wires leading to the glow plugs.
Control of the Mercedes glow relay is only precise to the nearest second
or so. If heating time of less than 1 second is specified the relay may not
turn on at all.

2.3.5 Engine speed sensor
The factory OM605/OM606 crank speed sensor is preferred but may
not be an option on engines converted from mechanical to EDC. An
alternative is to fit a hall effect sensor (1GT101 or GS100102 for example)
to read the TDC stud located on the front of the crankshaft harmonic
damper (may not work if the damper has any other features the sensor
may pick up, such as notches cut). A sensor reading the starter ring
gear can also be used. Having more than one tooth per engine rotation
is preferrable for idle control and anti stall performance with a manual
transmission.

2.3.6 Injection pump
The injection pump has a single connector bringing out all of its features.
Refer to connector B pin-out for wiring information. Power is supplied to
the rack solenoid through an internal relay in the ECU, this is for safety
reasons, enabling the ECU to cut power to the injection pump in case of
component failure. The rack control solenoid draws high current. It is
highly recommended that all four pins provided to supply the solenoid
from connector B are used.

2.3.7 Pedal position sensor
The ECU can utilise either single potentiometer with idle switch as found
on most older electronically controlled diesels (including Mercedes OM60x)
as well as dual potentiometer and solid state units.
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2. Wiring 2.3. Wiring guidelines

PPS pin Wire colour Function ECU pin
1 blue/green primary 5V

feed
1

2 brown secondary
ground

4 or chassis ground as in
OEM

3 blue/grey secondary 5V
feed

1

4 violet/yellow secondary
signal

3

5 violet/green primary signal 2
6 blue primary ground 4

Figure 2.7: Wiring for Mercedes W210 OM60x diesel accelerator pedal
position sensor. Round body, part number A0115428617

PPS pin Wire colour Function ECU pin
1 blue/brown 5V feed 1
2 no connection
3 brown/white sensor ground 4
4 violet/yellow secondary signal 3
5 violet/green primary signal 2
6 brown/yellow sensor ground 4

Figure 2.8: Wiring for Mercedes W210 petrol engine or common rail
accelerator pedal position sensor, part number A0125423317 and others.
Also found on other chassis.

2.3.8 MAP sensor
If using the standard W210 MAP sensor, the table below describes its
wiring, two different colour schemes are known but pin numbers are the
same. Sometimes the pins are labeled inside the connector of the sensor,
with V for 5V input, G for sensor ground and O for signal output.

MAP pin Wire colour Function ECU pin
1 blue/red or grey/violet signal 15
2 brown/white or brown/yellow sensor ground 16
3 blue/black or white/black +5V feed 13

If using a 4 bar GM style MAP sensor such as the one sold in the web
shop, the table below describes its wiring:
MAP pin Function ECU pin
A sensor ground 16
B signal 15
C +5V feed 13

2.3.9 Programmable outputs
The ECU has four programmable outputs and while all low speed functions
are applicable to every output, some PWM functions have dedicated
outputs. This means that if those functions are used, they can only be
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2. Wiring 2.4. Useful notes about the factory OM606 wiring harness

assigned to the specified output. Firmware version 1.15 reduces the
number of dedicated function assignments to only two. The rest of the
functions can be freely assigned to any output. The outputs are low-side
switches meaning the negative terminal of whatever device that is to
be switched on is wired to the controller. The outputs are rated for 3A
continuous current so anything that draws more current (Has a resistance
smaller than 4.5Ω) must be wired through a relay.

Function Output
Tachometer output 1
Speedometer output 2

Figure 2.9: Functions with dedicated outputs

2.4 Useful notes about the factory OM606 wiring harness
Most of the sensors on the engine (all except the MAP sensor) are brought
out in a loom that runs underneath the intake manifold and terminates
in a green connector. Alongside the green connector is a medium sized
purple wire. The purple wire is the control signal that goes to the starter
solenoid. The wires coming out of the green connector are as follows:

Pin Wire colour Function Connects where
2 brown/black Oil level sensor Not used
3 brown Fuel shut off solenoid

ground
Any power ground

4 yellow/black Fuel shut off solenoid
positive

Switched 12V
source

5 brown/white Sensor ground DSL1 conn A pin
16

6 green/red Coolant temperature sensor DSL1 conn A pin
14

7 green/white Air temperature sensor Not used
8 blue/white Fuel temperature sensor Not used
12 clear Engine speed sensor ground DSL1 conn A pin

16
13 green Engine speed sensor DSL1 conn A pin

19

Figure 2.10: Green connector pin-out

Note that the engine speed sensor wire is green, housed inside a shield,
covered by black isolation.
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3. Software configuration

3 Software configuration

Refer to BG calibrator manual for introduction to the PC application.

3.1 Theory of operation
The injection metering rack position is determined by monitoring the
inductance of the two coils in the rack position sensors and comparing
their values. The rack position does not have a unit of measure.Rack
control parameters -> Rack position request is the transfer function
that converts a requested injection amount into a target rack position.
Its calibration does not have to reflect the actual metered fuel quantity
but for good idle control, reasonable linearity at small injection amounts
helps.
The base fuel injection quantity, in cc per 1000 events as is tradition with
diesel pump evaluation, is set by the Fuel request table as a function
of engine speed and throttle pedal position. The Fuel limit table is
applied on top of that result to limit the injection quantity if charge
air pressure (boost) is low. If using the unit to control turbocharger
pressure, the requested fuel injection quantity (ignoring the limit table)
is used as an input to the Boost target table. The metering rack is
controlled by a PID feedback loop. The P in the PID is proportional and
provides quick response. Too much P gain causes rapid oscillations when
the target position is reached. The oscillations can be dampened by the
D factor which is a derivative of the rack position and counters quick
movements. Fine control is done by the I factor, the integrator. Too little
integrator gain can cause slow oscillations as the control won’t react fast
enough when over/under target.
The controller is supplied with a reasonable set of default settings off a
running engine, but some fine tuning may be necessary, especially of the
Rack position request function as there are some variations in rack
position sensor feedback between different pumps which are not perfectly
compensated for by the rack position sensor control. Manual transmission
cars require more attention in this area for good drivability than cars
equipped with automatic transmissions.
Engine idle is controlled by a second PID loop. Idle control is active when
numbers in the fuel request table are lower than what’s required for the
engine to idle. It is therefore important that the fuel request table has
small numbers in the idle region, but too small cause the engine to return
to idle too quickly and it may stall. Too large and the engine won’t
return to idle at all. This has to be tuned with the engine fully warmed
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3. Software configuration 3.2. Getting started

up as a warm engine has much lower friction than a cold one and thus
requires less fuel to idle. If the idle is hunting it helps to record a data log
and observe the rackP, rackI, rackD, rackposition, rackrequest,
idleP, idleI, idleD parameters in relation to engine speed over time
to determine which parameters are leading the control. In general, a
slowly hunting idle is caused by not enough P/I gain in either rack control
or idle control, sometimes both. If tuning the parameters does not amend
it, a hunting idle may also be an indication of poor injection pump condition.
If the pump has too much friction the metering rack may need excessive
feedback to move freely. This problem may in some cases be masked by
lowering the rack PWM frequency to induce vibration and keep the rack
moving.

Figure 3.1: Fuel request table

3.2 Getting started
After you have wired up the controller and connected with the calibrator
application, there are a number of things you must check before attempting
to start the engine.

3.2.1 Engine speed sensor calibration
Select Sensor inputs -> Frequency inputs. If you have an OM605
engine with the stock 5 lug crank trigger, set the speed pulses per two
rotations to 5 and pulse averaging to 1. If you have an OM606, use 6
pulses and 1 averaging. The way these settings work is that the ECU will
ignore as many pulses as the averaging setting indicates before counting
the next pulse. Effectively dividing the number of pulses actually seen by
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3. Software configuration 3.3. Performing firmware upgrades

1+x where x is the averaging value. On the 605 for example, you have 10
pulses in two rotations but only 5 cylinders. It is counterproductive to
take an engine speed reading more often than the number of cylinders
so the divider is used to reduce the pulse count. Engine speed filter
period should be set to a number smaller than the shortest possible pulse
interval sent by the speed sensor. For an engine that sends 12 pulses
across two rotations turning 8000RPM the shortest plausible interval
is 1250 µs so the default of 1000 µs is a good choice for most installs.

3.2.2 Pedal position sensor calibration
Select Sensor inputs -> Pedal/rack position inputs -> Pedal
position voltage sensing range and verify that with the pedal up
the voltage of analog0 is less than or equal to the left number in that
table. Depress the pedal fully and verify that the voltage is equal or
greater than the right number. Check that error1 is zero and that the
pedalsecondary is always greater than pedalposition across all of the
pedal range, and that with the pedal up the pedalsecondary is at a
lower value than it is when the pedal is depressed. If error0 and error1
are zero you are ready to start the engine.

3.2.3 Rack position calibration
This step is best done after engine has been warmed up. With the engine
not running, depress the accelerator pedal to the floor and verify that
rackposition roughly equals rackcommand and that rackpulsewidth
does not continue to rise while the pedal is being held to the floor. If
rackpulsewidth continues climbing but rackposition does not, you
must reduce the maximum number in the Rack control parameters ->
Rack position request function. If the pulse width is allowed to climb
continually, rack solenoid overheating is possible during long periods of
full throttle operation. Next thing to check is that the idlefuelrequest
is no less than about 10 µL/event after the engine has warmed up and
engine is idling. If it is smaller, adjust the rack positions for small fuel
quantities in the Rack position request function, lowering the numbers
by maybe 20 units at a time until there is some headroom for the idle
control to reduce fuel.

3.3 Performing firmware upgrades
Whenever new features are introduced, new firmware becomes available
for download at https://controls.is/firmware/. See the release notes
if you are unsure of whether you should update or not.
To perform a firmware upgrade:

1. Download firmware package from web site

2. Unzip firmware package into a directory on your hard drive

16
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3. Software configuration 3.3. Performing firmware upgrades

3. Connect USB cable between ECU and PC.

4. Power on ECU, do not start engine.

5. If you do not have the configuration backed up, run BG Calibrator,
read configuration from ECU and save to file. This step may be
skipped if you are performing the upgrade on an ECU you haven’t
made any previous configuration changes to.

6. Run upgrade.cmd in directory where firmware files are located.

7. Wait until the upgrade application finishes, should be on the order
of 10 seconds.

8. Power ECU off.

9. Do not power ECU back on until you are ready to upload configuration
to it.

The ECU has been upgraded but now contains the default configuration.
If you are proceeding with default configuration, simply open the default
configuration file for the new firmware in BG calibrator and go on-line.
Otherwise, if you wish to retain your previous configuration, which is
generally recommended, perform the following steps:

1. Run the BG Calibrator software

2. Open your old configuration file

3. Select File -> Convert configuration from the menu bar.

4. Select the configuration included with the new firmware in the file
dialog.

5. The configuration has now been converted to the new format, save
it and exit the Calibrator software.

6. Run the Calibrator software again and open the configuration file
you saved previously, choose to work off-line.

7. Review the settings and verify that they make sense, see release
notes for information about what settings may need revisiting.

8. Go on-line and power on the ECU. Do not start engine.

9. When prompted, select to use local settings, which will then be
uploaded to the ECU.

After the configuration has been sent to the ECU and Calibrator application
becomes responsive again, power the ECU off and then back on. Now you
can start the engine.
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4. Extended features

4 Extended features

4.1 Cruise control
In order to use the cruise control, your controller must be using firmware
version 1.6 or greater. The cruise control requires three switches wired
multiplexed into analog input 5. The resume/accel switch goes via 22kΩ
resistor to ground, the set/decel switch goes via 10kΩ resistor to ground
and a cancel switch directly to ground with no added series resistance.
For best results these switches should ground to or near the control unit.
For cancel input, one should at least have a brake pedal switch (or relay
actuated from the brake light circuit) but may also have others wired in
parallel such as a clutch switch and/or hand operated cancel switch. For
automatic transmission applications, a vehicle speed input is necessary
for cruise control operation. For manual transmission applications it is
recommended that the vehicle speed input is wired for safety reasons
(blocking cruise control from engaging below a certain vehicle speed) but
not strictly necessary. If a visual indicator is desired when the cruise
control is active, use one of the general purpose outputs and set a condition
to turn on when flag_cruise = 1. Note that in firmware 1.9 and earlier,
the accel switch functions as set and decel switch functions as resume.
This was corrected in firmware version 1.10 to match tradition as per the
auto industry. For smooth operation of the cruise control, the road speed
signal must be reasonably clean. If you are seeing variations of several
km/h indicated when holding a steady speed you may be able to correct
that using the VSS smoothing and pulse averaging functions.

Figure 4.1: Typical cruise control switch wiring
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4. Extended features 4.2. Speedometer output

The cruise control has a number of outputs that are of interest in the real
time data feed.

cruisethrottle Throttle input from cruise control function.

cruiseP, cruiseI, cruiseD Cruise control PID loop output.

flag_cruise Indicator that cruise control is active.

cruiseswitch State indicator for cruise control switches.
Value Description

0 No switch active
1 Stop switch active
2 Set/decel switch active
3 Resume/accel switch active

4.2 Speedometer output
The DSL1 can as of firmware version 1.10 output a square wave signal
to control a speedometer on output 2. This can be used to calibrate the
speedometer in case the car has been fitted with different tyres or gear
ratios. To use this function, select speedometer output as the function for
output 2, write to flash and power cycle the controller. Then to calibrate,
enter a speed to indicate in General purpose outputs -> Speedometer
output test speed and adjust the value of Speedometer output pulses
per kilometre until the speed indicated on the speedometer matches
the configured test value. Set the test speed to zero when done. If the
speedometer behaves strange when at full throttle, it may be necessary to
rewire the speedometer and possibly the vehicle speed sensor, best noise
performance is expected when each of those is grounded to the DSL1
sensor ground.

4.3 OFGear 722.6 controller integration via CAN bus
It is possible to send throttle position, engine speed and boost pressure
to a transmission controller using the CAN bus, removing the need for
the transmission controller to have its own sensors for those parameters.
This section describes the necessary steps to make this integration work.
For this option to work it is necessary that the OFGear controller has
an OLED screen and not an LCD screen. It is also necessary that the
OFGear controller has firmware version 186 or newer, and if it came
with older firmware it may need a hardware modification performed by
OFGear to bring it up to newest spec.

4.3.1 DSL1 software configuration
If your controller is sold with firmware 1.14 or later (July 2017), the
necessary CAN configuration is already present in the default software
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4. Extended features 4.4. OBD2 communications

configuration. If your controller is older, you will need to apply the configuration.
To make this easy a preset is provided. Select Tools -> Configuration
presets from the menu at the top of the screen in the Calibrator application.
In the CAN bus section of the dialog presented, double click 722.6 controller
integration and press OK. Now you have successfully applied the necessary
settings for the CAN broadcast. Power off the ECU and power it back on
to activate the CAN bus data rate setting.

4.3.2 Wiring
The CAN bus consists of two wires, preferrably twisted together. The
CAN-H signal which is found on pin 7 of the 24 pin connector on the
DSL1 connects to pin 2 of the 10 pin connector supplied with the OFGear
controller. The CAN-L signal which is found on pin 8 of the 24 pin connector
on the DSL1 goes to pin 1 of the 10 pin connector on the OFGear controller.
Near the end of the bus which is furthest away from the DSL1 controller,
which would be the OFGear end if there are no other devices on the bus,
it is necessary to connect a termination resistor across the two wires. The
resistor must have a value of 120 ohms.

4.3.3 OFGear controller configuration
To configure the OFGear controller for receiving TPS, engine speed and
boost from DSL1, use the joystick and navigate to the right from the
main screen until a page is shown titled CAN bus. Use the up/down
motion of the joystick to set the CAN bus mode to OM606. No further
configuration is necessary.

4.4 OBD2 communications
As of firmware version 1.16 it is possible to perform OBD2 over CAN
bus communications with the DSL1. This enables the use of accessories
that can display OBD2 data for instrumentation purposes (various OBD2
gauges, mobile phone applications and scan tools) as well as diagnostic
trouble code readout. The protocol implemented is ISO15765-4 11 bit
OBD over CAN.
To enable this functionality, the following configuration parameters must
be set:

CAN bus data mode 500kbit

CAN receiving enable Enabled

OBD2 service enable Enabled

For diagnostic trouble codes, see Appendix B
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Figure 4.2: OBD2 female connector as seen from the end the scan tool
plugs in to.

4.4.1 Wiring
The OBD2 connector has four essential connections. Pin 6 (CAN-H)
connects to DSL1 24 pin connector pin 7. Pin 14 (CAN-L) connects
to DSL1 24 pin connector pin 8. Pins 4 and 5 connect to ground (any
chassis ground will do) and pin 16 connects to +12V. The standard
specifies that the +12V should be taken through a fuse directly from
the battery but most OBD2 devices will also perform correctly if the 12V
source is switched. For correct operation it may be necessary to have a
120 ohm termination resistor connected across the CAN wires if there is
none connected to the CAN bus already.

Figure 4.3: Typical wiring of OBD2 connector

4.5 Injection pump angle logging
As of firmware 1.18 it is possible to fit a sensor to the injection pump and
log the behaviour of the pump timing device. To do this the vehicle speed
input must be sacrificed, but vehicle speed can be received over CAN bus
instead, either from a transmission controller or a general purpose CAN
bus sensor interface such as https://controls.is/mpc1.html.
A prerequisite for the ability to log the pump angle is that the engine
speed reference must have teeth spaced further apart than the range of
the pump timing. This rules out the use of starter ring gear for engine
speed but any method with less than 12 pulses per crankshaft rotation
will work. Factory fitted OM605/OM606 trigger with 5 or 6 teeth is ideal.
The pumpangle variable displays the pump timing in crankshaft degrees
before the engine speed impulse, and is updated every time an engine
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speed impulse is seen after a pump timing impulse is seen. Greater numbers
are more advance. These numbers do not relate to top dead centre but
the variation will illustrate the behaviour of the pump timing device as a
function of engine speed and other parameters. The accuracy is reduced
when crank acceleration/deceleration is very fast. (revving in neutral,
shifting up, etc.)
The sensor known to work for this purpose is part number LCZ260 manufactured
by Honeywell. The sensor body has a 3/8′′ UNF thread and fits inside
the hole for the pump locking tool. The existing plug may be drilled
and tapped. When installing the sensor, turn the engine until the pump
timing mark shows, then thread in the sensor until the sensor bottoms
out against the pump timing mark and back off about one and one quarter
turns. Then rotate the engine by hand two full rotations to verify that
the sensor is not in interference with any feature of the pump which
would destroy the pump if engine was cranked over by the starter motor.
Wire the sensor as follows:
Wire Connection
Black Sensor ground, DSL1 pin 16.
Red Supply voltage, switched 12V supply.
White Signal output, DSL1 pin 20.

Two items must be configured on the ECU configuration. First set Road
speed source to any of the CAN sources, even if you do not plan to use
it. Next enable Use road speed input for pump angle instead.
Some noise is present on pump angle signal due to the pick up of features
on the pump cam other than the one locking tool pawl, but this is of
little consequence. The best way to read this data is to use the histogram
feature of the log viewer to average out the noise and generate a tabular
display showing the angle as a function of engine speed and fuel quantity
or throttle position as the injection pump has been observed to require
more torque when injecting greater fuel quantities, affecting the operation
of the centrifugal pump timing device.
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Figure 4.4: Honeywell LCZ260 sensor installed in injection pump

Figure 4.5: Pump angle analysis using histogram view in log viewer
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A Real time data fields

As of firmware 1.18, the real time data fields are described in the configuration
file. Hover the mouse over any variable in the right hand side real time
variable display to see the description or open the real time display panel
properties from the tools menu or by right clicking the real time variable
display.
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B Error codes

The error codes are stored on three bit masks, error0, error1 and error2,
as described in the previous chapter. They can be read using the Calibrator
application (Communication -> View controller errors in on-line
mode, Tools -> Decode error variables in log view mode). It is also
possible to read the errors using an OBD2 scan tool if OBD2 connector is
wired and OBD2 communications are enabled in the configuration. OBD2
DTC codes take the form of P3XZZ where X is the error variable, 0 for
error0 and so on and ZZ is the bit offset in that variable, starting with 00.
Note that these codes do not correspond with any auto manufacturer’s
codes.

Errors that prohibit engine starting:
Value Description
P3000 Primary rack position sensor high (open circuit)
P3001 Rack reference sensor high (open circuit)
P3002 Primary rack position sensor low (short to ground)
P3003 Rack reference sensor low (short to ground)
P3004 Rack position exceeding target position
P3011 Engine disabled due to test mode
P3012 Configuration error
P3013 Firmware crashed
P3014 Firmware crashed in interrupt mode
P3015 Firmware crashed in priority interrupt

Errors that let the engine start and idle but disable the accelerator pedal:
Value Description
P3100 Throttle pedal voltage high
P3101 Throttle pedal voltage low
P3102 Throttle sensors disagree
P3103 Secondary throttle sensor out of range

Errors that will allow vehicle operation, but possibly at reduced performance:
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Value Description
P3200 MAP sensor voltage low
P3201 MAP sensor voltage high
P3202 Coolant temp sensor open circuit
P3203 Coolant temp sensor short circuit
P3204 Loss of CAN input data (one or more configured CAN data

sources not receiving data)
P3205 Fuel pressure sensor low voltage (short to ground)
P3206 Fuel pressure sensor high voltage (open circuit)
P3207 Fuel feed pressure too low
P3208 Fuel feed pressure too high
P3209 Real Time Clock battery fault or no RTC battery fitted. Note

that RTC is only used if controller fitted with internal data
logging option.
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D DSL1 plug and play adaptor

Introduced in Q3 2019, the plug and play adaptor allows the use of a
DSL1 ECU in a car that came with OM606 or OM605 engine as well as
OM602.980 without modifying the car’s wiring. Typical output configuration
necessary to utilise the plug and play adaptor:

Output 1 55p pin 14. Normally unused. On older W202 cars without
CAN bus instruments this pin is the tachometer output.

Output 2 55p pin 11. Normally unused. On some naturally aspirated
cars this pin controls a valve in the intake manifold plenum.

Output 3 55p pin 52. Normally unused. On some naturally aspirated
cars this pin controls a butterfly valve in the air intake.

Output 4 55p pin 49. Normally unused. On some older models with
an automatic transmission that is not a 722.6, this pin controls a
solenoid adjusting the transmission’s line pressure.

Output 5 55p pin 53. Wastegate control solenoid.

Output 6 55p pin 34. Normally unused. On some older models with
an automatic transmission that is not a 722.6, this pin controls the
transmission’s kick down solenoid.

Output 7 55p pin 43 but supplies positive voltage. Fuel shut off solenoid
control.

Output 8 55p pin 17. Starter relay control. On some EIS equipped
models the starter is engage by a CAN message. This pin may also
be grounded by a positive voltage input on 55p pin 13.

Input function association when using the plug and play adaptor:

Analog in 4 55p pin 21. MAF sensor. Not typically used for anything
but wired for sake of complete coverage.

Analog in 5 Cruise control circuit. Takes inputs from lots of pins on the
55pin header. What varies between models is how the brake pedal
signal is brought in to the ECU.

Analog in 6 55p pin 40. Intake air temperature sensor. Not typically
used for anything but wired for sake of complete coverage.
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Digital in 1 55p pin 1. Needle lift sensor on OM602.98x engines. Unused
on others. Note that an ECU with circuitry to deal with the low
voltage needle lift signal is a special order item.

The following page contains a schematic showing the internal wiring of
the plug and play adaptor. Part labeled X1 is the 55 pin header. Parts
labeled X2 through X4 are the connectors on the DSL1.
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